
ภาคผนวก



ภาคผนวก  ก 

รายชื่อผูเชี่ยวชาญในการตรวจสอบเครื่องมือที่ใชในการศึกษาคนควา



ภาคผนวก  ก 

รายชื่อผูเชี่ยวชาญในการตรวจสอบเครื่องมือที่ใชในการศึกษาคนควา 

1.  รศ.ดร.ประหยัด  จิระวรพงศ 
ตําแหนง  อาจารยประจําภาควิชาเทคโนโลยีและส่ือสารการศึกษา 
สถานที่ทํางาน  คณะศึกษาศาสตร  มหาวิทยาลัยนเรศวร 

2.  ผศ.ดร.ดิเรก  ธีระภูธร 
ตําแหนง  อาจารยประจําภาควิชาเทคโนโลยีและส่ือสารการศึกษา 
สถานที่ทํางาน  คณะศึกษาศาสตร  มหาวิทยาลัยนเรศวร 

3.  ผศ.ดร.รุจโรจน  แกวอุไร 
ตําแหนง  อาจารยประจําภาควิชาเทคโนโลยีและส่ือสารการศึกษา 
สถานที่ทํางาน  คณะศึกษาศาสตร  มหาวิทยาลัยนเรศวร 

4.  ผศ.ดร.ภาสกร  เรืองรอง 
ตําแหนง  อาจารยประจําภาควิชาเทคโนโลยีและส่ือสารการศึกษา 
สถานที่ทํางาน  คณะศึกษาศาสตร  มหาวิทยาลัยนเรศวร 

5.  ดร.ทิพรัตน  สิทธิวงศ 
ตําแหนง  อาจารยประจําภาควิชาเทคโนโลยีและส่ือสารการศึกษา 
สถานที่ทํางาน  คณะศึกษาศาสตร  มหาวิทยาลัยนเรศวร



ภาคผนวก  ข 

แบบสอบถามความตองการเว็บฝกอบรม  เร่ือง  การสรางหนังสืออิเลก็ทรอนิกส 
สําหรับครูผูสอน  สังกัดสํานักงานเขตพื้นท่ีการศกึษาพิษณุโลก  เขต  1



ภาคผนวก  ข 
แบบสอบถามความตองการเว็บฝกอบรม  เร่ือง  การสรางหนังสืออิเลก็ทรอนิกส 

สําหรับครูผูสอน  สังกัดสํานักงานเขตพื้นท่ีการศกึษาพิษณุโลก  เขต  1 

วัตถุประสงค
เพื่อศึกษาความตองการเว็บฝกอบรม  เรื่อง  การสรางหนังสืออิเล็กทรอนิกส  สําหรับ 

ครูผูสอน  สังกัดสํานักงานเขตพื้นทีก่ารศึกษาพษิณุโลก  เขต  1 

คําชี้แจง 
1.  แบบสอบถามนี้ใชสําหรับสอบถามความตองการเว็บฝกอบรม  เรื่อง  การสรางหนังสือ 

อิเล็กทรอนิกส
2.  แบบสอบถามชุดนี้  แบงเปน  3  สวน  ดังตอไปนี้ 

สวนที่  1  สภาพของผูตอบแบบสอบถามและความตองการเว็บฝกอบรม 
สวนที่  2  ความตองการเนื้อหาและองคประกอบเว็บฝกอบรม 
สวนที่  3  ความคิดเหน็และขอเสนอแนะ 

3.  ขอความกรุณาใหทานไดอานคําถามใหชัดเจน  แลวตอบแบบสอบถามใหตรงกบัความ 
คิดเหน็ของทาน  และกรณุาตอบใหครบทุกขอ 

4.  ความคิดเห็น  ขอเสนอแนะและขอเทจ็จริงที่ไดจากการสอบถามนี้  จะเปนขอมูลที่มี 
ประโยชนและมคีวามสําคัญอยางยิง่ในการศึกษาคนควาดวยตนเอง  ซึ่งคณะผูศึกษาคนควา 
จะเกบ็ขอมูลของทานใหเปนความลับที่สุด  และจะเปนประโยชนในการศกึษาคนควาเทานั้น 

คณะผูพัฒนา  นางสาวกนกพร    ตฤปอัชฌา 
นางสาวสิริญญา  นิ่มนวล 
นางสาวสุพรรษา  พลับจุย 

สาขาวิชา  เทคโนโลยีและการสื่อสารการศึกษา  แขนงคอมพิวเตอรศกึษา 
คณะศึกษาศาสตร  มหาวิทยาลัยนเรศวร  จังหวัดพิษณุโลก 

ท่ีปรึกษา  รองศาสตราจารยถาวร  สายสืบ



แบบสอบถาม 
ความตองการเวบ็ฝกอบรม  เร่ือง  การสรางหนังสืออิเล็กทรอนิกส 

สําหรับครูผูสอน  สังกัดสํานักงานเขตพื้นท่ีการศกึษาพิษณุโลก  เขต  1 

คําชี้แจง  โปรดตอบคําถาม  โดยใหทานทําเครื่องหมายü  ลงในชอง ÿ  ที่ทานเห็นวาตรงกับ 
ความคิดเหน็ของทาน 

สวนท่ี  1  สภาพของผูตอบแบบสอบถามและความตองการเว็บฝกอบรม 
1.  เพศ 
ÿ  ชาย  ÿ  หญิง 

2.  ทานเปนครูผูสอนระดับ 
ÿ  กอนประถมวัย  ÿ  ชวงชั้นที่  1  ÿ  ชวงชั้นที่  2 
ÿ  ชวงชั้นที่  3  ÿ  ชวงชั้นที่  4 

3.  ทานเปนครูผูสอนในกลุมสาระการเรยีนรู 
ÿ  คณิตศาสตร  ÿ  วิทยาศาสตร 
ÿ  ภาษาไทย  ÿ  ภาษาตางประเทศ 
ÿ  สังคมศึกษา ศาสนาและวัฒนธรรม  ÿ  สุขศึกษาและพลศึกษา 
ÿ  ศิลปะ  ÿ  การงานอาชีพและเทคโนโลยี 
ÿ  อ่ืนๆ  ระบุ  ..................................................................................... 

4.  ทานใชเครือขายอินเทอรเน็ตในการทํากจิกรรมใด (ตอบไดมากกวา 1 ขอ) 
ÿ  สืบคนขอมูล  ÿ  ฝกอบรม / การเรียน 
ÿ  ติดตอส่ือสาร  ÿ  สงจดหมายอเิล็กทรอนกิส 

5.  ทานเคยไดรับการฝกอบรม  การสรางหนังสืออิเลก็ทรอนิกสหรือไม 
ÿ  เคย  ÿ  ไมเคย



6.  ทานมีความตองการใชสื่อการสอน  ในรูปแบบของหนังสืออิเล็กทรอนิกสหรือไม 
ÿ  ตองการ  ÿ  ไมตองการ (ขามไปสวนที่ 3) 

7.  ทานตองการใหมเีว็บฝกอบรม  เรื่อง  การสรางหนังสืออิเล็กทรอนิกสหรือไม 
ÿ  ตองการ  ÿ  ไมตองการ (ขามไปสวนที่ 3) 

สวนท่ี  2  ความตองการเนื้อหาและองคประกอบเว็บฝกอบรม 
1.  ถามีการพัฒนาเว็บฝกอบรม  เรื่อง  การสรางหนังสืออิเล็กทรอนิกส  ทานคิดวา 

ควรมีเนื้อหาอะไรบาง (ตอบไดมากกวา 1 ขอ) 
1)  ความรูเบื้องตนเกีย่วกับหนังสืออิเลก็ทรอนิกส 
2)  การออกแบบและพัฒนาหนังสืออิเลก็ทรอนิกส 
3)  การสรางหนังสืออิเลก็ทรอนกิสดวยโปรแกรมสําเร็จรูป 
4)  การสรางแบบทดสอบดวยโปรแกรมสรางหนังสืออิเล็กทรอนิกส 
5)  การนําไฟลหนังสืออิเลก็ทรอนกิสไปใชงาน 
6)  อ่ืน ๆ  .................................................................................... 

2.  ถามีการพัฒนาเว็บฝกอบรม  เรื่อง  การสรางหนังสืออิเล็กทรอนิกส  ทานคิดวา 
ควรมีองคประกอบอะไรบาง (ตอบไดมากกวา 1 ขอ) 

ÿ  หนาหลกั  ÿ  แผนผังเว็บไซต 
ÿ  สวนเมนู  ÿ  กระดานขาว 
ÿ  สมัครสมาชิก  ÿ  หองสนทนา 
ÿ  เนื้อหาการฝกอบรม  ÿ  สมุดเยี่ยม 
ÿ  จุดประสงคของการฝกอบรม  ÿ  คําถามที่พบบอย 
ÿ  จุดประสงครายหนวย  ÿ  สืบคนขอมูล 
ÿ  แบบทดสอบ  ÿ  สถิติผูเขาชม 
ÿ  ติดตอผูฝกอบรมหรือวิทยากร  ÿ  เทคนิคนารูตาง ๆ 
ÿ  ปฏิทินนัดหมาย  ÿ  ขาวประชาสัมพันธ 
ÿ  เว็บทีเ่กี่ยวของ  ÿ  ดาวนโหลด 
ÿ  แหลงอางอิง  ÿ  คูมือการใชเวบ็ฝกอบรม 
ÿ  อ่ืน ๆ ระบุ ...........................................................................................



สวนท่ี  3  ความคิดเห็นและขอเสนอแนะ 
............................................................................................................................................. 
.............................................................................................................................................. 
.............................................................................................................................................. 
.............................................................................................................................................. 
.............................................................................................................................................. 
.............................................................................................................................................. 

ขอขอบคุณทุกทาน  ที่ใหความรวมมือในการตอบแบบสอบถาม 
นิสิตปริญญาโท  สาขาวิชาเทคโนโลยีและสื่อสารการศึกษา 

แขนงคอมพิวเตอรศึกษา  คณะศกึษาศาสตร 
มหาวิทยาลัยนเรศวร  จังหวัดพิษณุโลก



ภาคผนวก ค 

1.  คาดัชนีความสอดคลองของแบบประเมินเว็บฝกอบรม  เรื่อง  การสรางหนังสืออิเล็กทรอนิกส 
สําหรับครูผูสอน  สังกัดสํานักงานเขตพืน้ทีก่ารศึกษาพษิณุโลก  เขต  1 (สําหรับผูเชี่ยวชาญ) 

2.  แบบประเมินเว็บฝกอบรม  เรื่อง  การสรางหนังสืออิเลก็ทรอนิกส  สําหรับครูผูสอน 
สังกัดสํานกังานเขตพื้นที่การศึกษาพิษณุโลก  เขต  1 (สําหรับผูเชี่ยวชาญ)



ภาคผนวก ค 

ตาราง  15  แสดงคาดัชนีความสอดคลองของแบบประเมินเว็บฝกอบรม  เร่ือง  การสราง- 
หนังสืออิเล็กทรอนิกส  สาํหรับครูผูสอน  สังกดัสาํนักงานเขตพื้นท่ีการศกึษา 
พิษณุโลก  เขต  1 (สาํหรับผูเชีย่วชาญ) 

ผูเชี่ยวชาญ ขอ 
ที่  รายการประเมนิ  คนที่ 

1 
คนที่ 
2 

คนที่ 
3 

IOC 

สวนนําบทเรยีน 
1  การนําเขาสูเนื้อหาการฝกอบรมมคีวามนาสนใจ  1  1  1  1.00 
2  การออกแบบบทเรียนในการฝกอบรมมีความ 

สวยงาม  และสะดวกใช 
1  1  1  1.00 

3  มีการแจงจดุประสงคใหผูเขารับการฝกอบรมทราบ 
อยางชัดเจน 

1  1  1  1.00 

4  มีการชี้แจงขัน้ตอน/วิธีการ  การเรยีนรูใหผูเขา 
ฝกอบรมทราบอยางชดัเจน 

1  1  1  1.00 

สวนเนื้อหาของบทเรียน 
5  เนื้อหามีความสอดคลองกบัจุดประสงคการ 

ฝกอบรม 
1  1  1  1.00 

6  จัดโครงสรางของเนื้อหาชัดเจน  1  1  1  1.00 
7  เนื้อหามีความสัมพนัธและตอเนื่องกันเปนไป 

ตามลําดับขั้นตอนของการเรียนรู 
1  1  1  1.00 

8  เนื้อหามีความยาก งายเหมาะสมกับผูเขารับการ 
ฝกอบรม 

1  1  1  1.00 

9  จํานวนขอสอบครอบคลุมเนื้อหาและมีความ 
เหมาะสม 

1  1  1  1.00



ตาราง  15 (ตอ) 
ผูเชี่ยวชาญ ขอ 

ที่  รายการประเมนิ  คนที่ 
1 

คนที่ 
2 

คนที่ 
3 

IOC 

สวนการออกแบบระบบการเรียนการสอน 
10  มีการออกแบบการเรียนรูอยางเปนระบบ  1  1  1  1.00 
11  เนื้อหาของบทเรียนมีความยืดหยุนสนองความ 

แตกตางระหวางบุคคล 
1  1  1  1.00 

12  เทคนิคการถายทอดเนื้อหาของบทเรียนมีความนาสนใจ  1  0  1  0.67 
13  การประเมินผลมีความเหมาะสม  1  1  1  1.00 
14  การออกแบบหนาจอมีความเหมาะสมสวยงาม 

นาสนใจ  งายตอการใช  และมีการใชหลกัการ 
ออกแบบที่ดี 

1  1  1  1.00 

15  มีการใชรูปภาพที่สื่อความหมายชัดเจนและสอดคลอง 
กับเนื้อหา 

1  1  1  1.00 

16  รูปภาพสามารถนําเสนอเนื้อหาและการสาธิตไดชัดเจน 
เขาใจงาย 

1  1  1  1.00 

17  รูปแบบ  ขนาดและสีของตัวอักษรมีความเหมาะสม 
อานงาย  ชัดเจน 

1  1  1  1.00 

สวนการออกแบบปฏิสัมพนัธ 
18  มีการออกแบบเสนทางการเดินบทเรยีนสะดวก  ชัดเจน 

ใชงาย  ถกูตองตามหลกัเกณฑ 
1  1  1  1.00 

19  เครื่องมือที่ใชในการสนับสนุนการฝกอบรมเหมาะสม 
เชน  สมุดรายงาน, สงขอความ, ตารางนัดหมาย และ 
สมุดบันทกึ 

1  1  1  1.00 

20  บทเรียนสามารถแสดงผลไดรวดเร็วฉับไว  1  1  1  1.00 
21  ความสามารถในการเชื่อมโยงเอกสาร  ถูกตองเหมาะสม  1  1  1  1.00 
22  มีสวนใหความชวยเหลือเมื่อผูเขารับการอบรมตองการ  1  1  1  1.00 

รวมเฉลี่ย  0.99



แบบประเมินเว็บฝกอบรม  เร่ือง  การสรางหนังสืออิเลก็ทรอนิกส 
สําหรับครูผูสอน  สังกัดสํานักงานเขตพื้นท่ีการศกึษาพิษณุโลก  เขต  1 

(สําหรับผูเชี่ยวชาญ) 

คําชี้แจง 
1.  แบบสอบถามชุดนี้  มีวัตถปุระสงคเพื่อประเมนิคุณภาพของเว็บฝกอบรม 

เรื่อง  การสรางหนังสืออิเล็กทรอนิกส  สําหรับครูผูสอน  สงักัดสํานักงานเขตพื้นทีก่ารศึกษาพษิณุโลก 
เขต  1  ซึ่งจดัทําข้ึนสําหรับผูเชี่ยวชาญแสดงความคดิเห็นใน  5  สวน  ดังนี้ 

สวนที่  1  สวนนําบทเรียน 
สวนที่  2  สวนเนื้อหาของบทเรียน 
สวนที่  3  สวนการออกแบบระบบการเรียนการสอน 
สวนที่  4  สวนการออกแบบและกราฟก 
สวนที่  5  สวนการออกแบบปฏิสัมพันธ 

2.  โปรดใสเครื่องหมายü  ลงในชองระดับการประเมนิ  5  ระดับ  ตามความคิดเหน็ 
ของทาน  ดังนี้ 

5  หมายถึง  ดีมาก 
4  หมายถึง  ดี 
3  หมายถึง  ปานกลาง 
2  หมายถึง  พอใช 
1  หมายถึง  ควรปรับปรุง 

3.  หากทานมีขอเสนอแนะกรุณาเพิ่มเติมลงในชอง ขอเสนอแนะ



แบบประเมินเว็บฝกอบรม  เร่ือง  การสรางหนังสืออิเลก็ทรอนิกส 
สําหรับครูผูสอน สังกัดสาํนักงานเขตพื้นท่ีการศกึษาพิษณุโลก เขต 1 

(สําหรับผูเชี่ยวชาญ) 

คําชี้แจง  กรุณาใสเครื่องหมายü ลงในชองคะแนนทีต่รงกับความคิดเหน็ของทาน 

ระดับคะแนนคุณภาพ ขอ 
ที่ 

รายการประเมนิ 
5  4  3  2  1 

สวนนําบทเรยีน 
1  การนําเขาสูเนื้อหาการฝกอบรมมคีวามนาสนใจ 
2  การออกแบบบทเรียนในการฝกอบรมมีความสวยงามและ 

สะดวกใช 
3  มีการแจงจดุประสงคใหผูเขารับการฝกอบรมทราบอยางชดัเจน 
4  มีการชี้แจงขัน้ตอน/วิธีการ  การเรยีนรูใหผูเขาฝกอบรม 

ทราบอยางชัดเจน 
สวนเนื้อหาของบทเรียน 

5  เนื้อหามีความสอดคลองกบัจุดประสงคการฝกอบรม 
6  จัดโครงสรางของเนื้อหาชัดเจน 
7  เนื้อหามีความสัมพนัธและตอเนื่องกันเปนไปตามลําดับ 

ขั้นตอนของการเรียนรู 
8  เนื้อหามีความยาก  งายเหมาะสมกับผูเขารับการฝกอบรม 
9  จํานวนขอสอบครอบคลุมเนื้อหาและมีความเหมาะสม 
สวนการออกแบบระบบการเรยีนการสอน 

10  มีการออกแบบการเรียนรูอยางเปนระบบ 
11  เนื้อหาของบทเรียนมีความยืดหยุนสนองความแตกตาง 

ระหวางบุคคล 
12  เทคนิคการถายทอดเนื้อหาของบทเรียนมีความนาสนใจ 
13  การประเมินผลมีความเหมาะสม



ระดับคะแนนคุณภาพ ขอ 
ที่  รายการประเมนิ 

5  4  3  2  1 
สวนการออกแบบและกราฟก 

14  การออกแบบหนาจอมีความเหมาะสม  สวยงาม  นาสนใจ 
งายตอการใชงาน  และมีการใชหลกัการออกแบบทีด่ี 

15  มีการใชรูปภาพที่สื่อความหมายชัดเจนและสอดคลองกับ 
เนื้อหา 

16  รูปภาพสามารถนําเสนอเนื้อหาและการสาธิตไดชัดเจน 
เขาใจงาย 

17  รูปแบบ  ขนาดและสีของตัวอักษรมีความเหมาะสมอานงาย 
ชัดเจน 

สวนการออกแบบปฏิสัมพันธ 
18  มีการออกแบบเสนทางการเดินบทเรยีนสะดวก  ชัดเจน  ใชงาย 
19  เครื่องมือที่ใชในการสนับสนุนการฝกอบรมเหมาะสม  เชน 

สมุดรายงาน, สงขอความ, ตารางนัดหมาย  และสมุดบันทึก 
20  บทเรียนสามารถแสดงผลไดรวดเร็วฉับไว 
21  ความสามารถในการเชื่อมโยงเอกสาร ถูกตองเหมาะสม 
22  มีสวนการใหความชวยเหลือเมื่อผูเขารับการอบรมตองการ 

ขอคิดเห็นและขอเสนอแนะเพิ่มเติม  ......................................................................................... 
.............................................................................................................................................. 
.............................................................................................................................................. 
.............................................................................................................................................. 
.............................................................................................................................................. 
.............................................................................................................................................. 

ลงชื่อ  ....................................................... ผูประเมิน 
(.........................................................)



ภาคผนวก ง 

1. คาดัชนีความสอดคลองของแบบประเมินเว็บฝกอบรม  เรื่อง  การสรางหนังสืออิเล็กทรอนิกส 
สําหรับครูผูสอน  สังกัดสํานักงานเขตพื้นทีก่ารศึกษาพษิณุโลก  เขต  1 
(สําหรับผูเขารับการฝกอบรม) 

2. แบบประเมินเว็บฝกอบรม  เรื่อง  การสรางหนังสืออิเล็กทรอนิกส  สําหรับครูผูสอน 
สังกัดสํานักงานเขตพื้นที่การศกึษาพิษณุโลก  เขต  1 (สําหรับผูเขารับการฝกอบรม)



ภาคผนวก ง 

ตาราง  16  แสดงคาดัชนีความสอดคลองของแบบประเมินเว็บฝกอบรม  เร่ือง  การสราง- 
หนังสืออิเล็กทรอนิกส  สาํหรับครูผูสอน  สังกดัสํานักงานเขตพื้นท่ีการศึกษา 
พิษณุโลก เขต  1 (สําหรับผูเขารับการฝกอบรม) 

ผูเชี่ยวชาญ ขอ 
ที่  รายการประเมนิ  คนที่ 

1 
คนที่ 
2 

คนที่ 
3 

IOC 

ปจจัยนําเขา 
1  การนําเขาสูบทเรียนมีความนาสนใจ  1  1  1  1.00 
2  เนื้อหาบทเรียนและเอกสารประกอบการอบรม 

ชัดเจน เหมาะสม 
1  1  1  1.00 

3  การออกแบบหนาจอมีความสวยงาม เราความ 
สนใจ 

1  1  1  1.00 

4  เมนูและสวนนําทาง สะดวกตอการ 
ใชงาน 

1  1  1  1.00 

5  รูปภาพและขอความสื่อความหมายไดชัดเจน  1  1  1  1.00 
6  การออกแบบกิจกรรมการฝกอบรมเหมาะสม ทําใหไดรับ 

ความรูและเขาใจงาย 
1  1  1  1.00 

7  บอกแหลงขอมูล โปรแกรมทีจ่ําเปนในการใชงาน  1  1  1  1.00 
8  จํานวนขอสอบและแบบทดสอบเหมาะสม  1  1  1  1.00 
ดานกระบวนการ 

9  มีการแจงวัตถปุระสงคการฝกอบรมที่ชดัเจน  1  1  1  1.00 
10  มีการแจงขั้นตอน/วิธีการ  การเรียนรูที่ชดัเจน เขาใจงาย  1  1  1  1.00 
11  เนื้อหามีความสอดคลองกบัวัตถุประสงคการ 

ฝกอบรม 
1  1  1  1.00 

12  ใชเทคนิคการนําเสนอเนื้อหาบทเรียนทีน่าสนใจ 
(เชน รูปภาพ) 

0  1  1  0.67



ตาราง  16 (ตอ) 

ผูเชี่ยวชาญ ขอ 
ที่  รายการประเมนิ  คนที่ 

1 
คนที่ 
2 

คนที่ 
3 

IOC 

13  เครื่องมือสนับสนนุการฝกอบรมมคีวามเหมาะสม เชน 
ระบบสงขอความ, สมุดรายงาน, สมุดบนัทึก และตาราง 
นัดหมาย 

1  1  1  1.00 

14  การแสดงผลเนื้อหาบทเรียน  รวดเร็ว  1  1  1  1.00 
15  ความสามารถในการเชื่อมโยงเอกสาร  ทั้งภายในและ 

ภายนอก 
1  1  1  1.00 

16  มีการทบทวนสรุปและเนนใหเห็นสวนที่สําคญัในแตละ 
บทเรียน 

1  1  1  1.00 

17  เปดโอกาสใหผูเขารับการอบรมมีสวนรวมในการเรียนรู  1  1  1  1.00 
ดานผลผลิต 

18  ทานไดรับแนวคิดและแนวทางในการสรางหนังสือ 
อิเล็กทรอนิกสจากตัวอยางที่ไดนําเสนอ 

1  1  1  1.00 

19  ความรูที่ไดรับจากการฝกอบรมดวยเว็บฝกอบรมนี้ ทาน 
สามารถนําไปพัฒนาสรางส่ือการเรียนการสอนของทาน 

1  1  1  1.00 

20  ทานมีความพึงพอใจในการฝกอบรมดวยเว็บฝกอบรม 
ในระดับ 

1  1  1  1.00 

รวมเฉลี่ย  0.98



แบบประเมินเว็บฝกอบรม  เร่ือง  การสรางหนังสืออิเลก็ทรอนิกส 
สําหรับครูผูสอน  สังกัดสํานักงานเขตพื้นท่ีการศกึษาพิษณุโลก  เขต  1 

(สําหรับผูเขารับการฝกอบรม) 

คําชี้แจง 
1.  แบบสอบถามชุดนี้มีวัตถุประสงค  เพื่อประเมนิความพงึพอใจของผูเขารับการ 

ฝกอบรมที่มีตอเว็บฝกอบรม  เรื่อง  การสรางหนังสืออิเล็กทรอนิกส  สําหรับครูผูสอน 
สังกัดสํานักงานเขตพื้นทีก่ารศึกษาพษิณุโลก  เขต 1  ใน  3  ดาน  คือ 

ดานที่  1  ดานปจจัยนําเขา 
ดานที่  2  ดานกระบวนการ 
ดานที่  3  ดานผลผลิต 

2.  โปรดใสเครื่องหมายü  ลงในชองระดับการประเมนิ  5  ระดับ  ตามความคิดเหน็ 
ของทาน  ดังนี้ 

5  หมายถึง  มากที่สุด 
4  หมายถึง  มาก 
3  หมายถึง  ปานกลาง 
2  หมายถึง  นอย 
1  หมายถึง  นอยที่สุด 

3.  หากทานมีขอเสนอแนะกรุณาเพิ่มเติมลงในชอง ขอเสนอแนะ



แบบประเมินเว็บฝกอบรม  เร่ือง  การสรางหนังสืออิเลก็ทรอนิกส 
สําหรับครูผูสอน  สังกัดสํานักงานเขตพื้นท่ีการศกึษาพิษณุโลก  เขต  1 

(สําหรับผูเขารับการฝกอบรม) 

คําชี้แจง  กรุณาใสเครื่องหมายü  ลงในชองคะแนนทีต่รงกับความคิดเห็นของทาน 

ระดับคะแนนคุณภาพ ขอ 
ที่ 

รายการประเมนิ 
5  4  3  2  1 

ปจจัยนําเขา 
1  การนําเขาสูบทเรียนมีความนาสนใจ 
2  เนื้อหาบทเรียนและเอกสารประกอบการอบรมชัดเจน 

เหมาะสม 
3  การออกแบบหนาจอมีความสวยงาม นาสนใจ 
4  เมนูและสวนนําทาง สะดวกตอการใชงาน 
5  รูปภาพและขอความสื่อความหมายไดชัดเจน 
6  การออกแบบกิจกรรมการฝกอบรมเหมาะสม ทําใหไดรับความรู 

และเขาใจงาย 
7  บอกแหลงขอมูล โปรแกรมทีจ่ําเปนในการใชงาน 
8  จํานวนขอสอบและแบบทดสอบเหมาะสม 
ดานกระบวนการ 
9  มีการแจงวัตถปุระสงคการฝกอบรมที่ชดัเจน 
10  มีการแจงขั้นตอน/วิธีการ  การเรียนรูที่เขาใจงาย 
11  เนื้อหามีความสอดคลองกบัวัตถุประสงคการฝกอบรม 
12  ใชเทคนิคการนําเสนอเนื้อหาบทเรียนทีน่าสนใจ (เชน รูปภาพ) 
13  เครื่องมือสนับสนนุการฝกอบรมมคีวามเหมาะสม เชน ระบบสง 

ขอความ, สมุดรายงาน, สมุดบันทกึ และตารางนัดหมาย 
14  การแสดงผลเนื้อหาบทเรียน  รวดเร็ว 
15  ความสามารถในการเชื่อมโยงเอกสาร  ทั้งภายในและภายนอก



ระดับคะแนนคุณภาพ ขอ 
ที่  รายการประเมนิ 

5  4  3  2  1 
16  มีการทบทวนสรุปและเนนใหเห็นสวนที่สําคญัในแตละบทเรียน 
17  เปดโอกาสใหผูเขารับการอบรมมีสวนรวมในการเรียนรู 
ดานผลผลิต 

18  ทานไดรับแนวคิดและแนวทางในการสรางหนังสือ 
อิเล็กทรอนิกส  จากตัวอยางที่ไดนําเสนอ 

19  ความรูที่ไดรับจากการฝกอบรมดวยเว็บฝกอบรมนี้ทานสามารถ 
นําไปพัฒนาสรางส่ือการเรียนการสอนของทาน 

20  ทานมีความพึงพอใจในการฝกอบรมดวยเว็บฝกอบรมในระดับ 

ขอคิดเห็นและขอเสนอแนะเพิ่มเติม  ......................................................................................... 
.............................................................................................................................................. 
.............................................................................................................................................. 
.............................................................................................................................................. 
.............................................................................................................................................. 
.............................................................................................................................................. 

ขอขอบคุณทุกทาน  ที่ใหความรวมมือในการตอบแบบสอบถาม 
นิสิตปริญญาโท  สาขาวิชาเทคโนโลยีและสื่อสารการศึกษา 

แขนงคอมพิวเตอรศึกษา  คณะศกึษาศาสตร 
มหาวิทยาลัยนเรศวร  จังหวัดพิษณุโลก



ภาคผนวก จ 

1.  คาดัชนีความสอดคลองระหวางจดุประสงคกับขอสอบของแบบทดสอบ 
2.  แสดงคาความยาก  คาอํานาจจําแนก  และคาความเชือ่มั่นของแบบทดสอบกอนและหลังเรียน 
3.  คะแนนเปรียบเทียบกอนการฝกอบรมและหลังการฝกอบรม 
4.  แบบทดสอบรายหนวย 
5.  แบบทดสอบหลังการฝกอบรม



ภาคผนวก จ 
ตาราง  17  แสดงคาดัชนีความสอดคลองระหวางจุดประสงคกบัขอสอบของแบบทดสอบ 

ผูเชี่ยวชาญ 
จุดประสงคการเรียนรู 

ขอสอบ 
ที่  คนที่ 

1 
คนที่ 
2 

คนที่ 
3 

คา
IOC 

1  1  0  0  0.33 
2  1  1  1  1.00 
3  1  0  1  0.67 
4  1  1  1  1.00 
5  1  1  1  1.00 
6  1  1  1  1.00 
7  0  1  1  0.67 
8  1  1  1  1.00 

จุดประสงคที่ 1 เพื่อใหมีความรูเบื้องตน 
เกี่ยวกบัหนังสืออิเล็กทรอนิกส 
1.  อธิบายความหมายของหนังสือ 

อิเล็กทรอนิกสได 
2.  อธิบายลักษณะ  รูปแบบ  และประเภท 

ของหนังสืออิเล็กทรอนิกสได 
3.  อธิบายองคประกอบของหนังสือ 

อิเล็กทรอนิกสได
(ขอ 1–ขอ 9)  9  1  1  1  1.00 

10  1  1  1  1.00 
11  1  0  1  0.67 
12  1  1  1  1.00 
13  1  1  0  0.67 
14  0  1  1  0.67 
15  1  1  1  1.00 
16  1  1  1  1.00 

จุดประสงคที่  2  เพื่อใหมีความรูในการ 
ออกแบบและพัฒนาหนังสืออิเล็กทรอนิกส 
1.  อธิบายคุณสมบัติของหนงัสือ 

อิเล็กทรอนิกสที่สรางดวยโปรแกรม 
DeskTop Author 

2.  อธิบายกระบวนการสรางและพัฒนา 
หนังสืออิเล็กทรอนิกสได 

(ขอ 10-ขอ 17)  17  0  1  1  0.67 
18  1  1  1  1.00 
19  1  1  1  1.00 
20  1  1  1  1.00 
21  1  1  1  1.00 

จุดประสงคที่  3  เพื่อใหมีความรู 
ความสามารถในการสรางหนังสือ 
อิเล็กทรอนิกส 
1.  อธิบายคุณสมบัติของหนงัสือ 

อิเล็กทรอนิกสที่สรางดวยโปรแกรม 
Desk Top Author 

22  1  1  0  0.67



ตาราง  17 (ตอ) 

ผูเชี่ยวชาญ 
จุดประสงคการเรียนรู 

ขอสอบ 
ที่  คนที่ 

1 
คนที่ 
2 

คนที่ 
3 

คา
IOC 

23  1  1  1  1.00 
24  1  1  1  1.00 
25  1  0  1  0.67 
26  0  -1  -1  -0.67 
27  1  1  1  1.00 
28  0  1  0  0.33 
29  1  1  1  1.00 
30  1  1  1  1.00 

จุดประสงคที่  3 (ตอ) 
2.  อธิบายกระบวนการสรางหนงัสือ 

อิเล็กทรอนิกสดวยโปรแกรม 
DeskTop Author 

(ขอ 18–ขอ 31) 

31  1  1  1  1.00 
32  1  0  1  0.67 
33  1  1  1  1.00 
34  1  1  0  0.67 
35  1  1  1  1.00 
36  1  0  1  0.67 
37  1  0  1  0.67 
38  1  1  1  1.00 
39  1  1  1  1.00 
40  1  1  1  1.00 
41  1  1  1  1.00 
42  1  1  1  1.00 

จุดประสงคที่  4  เพื่อใหมีความรูความสามารถ 
ในการสรางแบบทดสอบ 
1.  อธิบายการสรางแบบทดสอบชนิดตาง ๆ  ได 
2.  อธิบายการสรางปุมแสดงผลคะแนน 

ในแบบทดสอบได 
3.  อธิบายการสรางหนารายงานผลคะแนน 

ของแบบทดสอบได 
(ขอ 32–ขอ43 ) 

43  1  1  0  0.67



ตาราง  17 (ตอ) 

ผูเชี่ยวชาญ 
จุดประสงคการเรียนรู 

ขอสอบ 
ที่  คนที่ 

1 
คนที่ 
2 

คนที่ 
3 

คา
IOC 

44  0  1  0  0.33 
45  1  1  1  1.00 
46  1  1  1  1.00 
47  1  1  1  1.00 
48  1  1  1  1.00 
49  1  1  1  1.00 
50  1  1  1  1.00 
51  1  1  1  1.00 
52  1  1  1  1.00 
53  1  1  1  1.00 
54  1  1  1  1.00 

จุดประสงคที่  5  เพื่อใหมีความรู 
ความสามารถ  ในการนําไฟลหนังสือ 
อิเล็กทรอนิกสไปใชงาน 
1.  อธิบายการจัดเกบ็ (Package) ไฟล 

หนังสืออิเล็กทรอนิกสได 
2.  อธิบายวิธีการนําหนังสือ 

อิเล็กทรอนิกสที่สรางไปใชงานได 
(ขอ 44–ขอ55) 

55  0  -1  -1  -0.67 

จากตาราง  17  สรุปไดวาจํานวนขอสอบ  55  ขอ  เลือกขอสอบที่มีคา IOC มากกวา 
0.50  ไดจํานวน  50  ขอ  ดังนี้ 
จุดประสงคขอที่  1  ขอสอบที่ใชไดจํานวน  8  ขอ  คือขอที่  2, 3, 4, 5, 6, 7, 8, 9 
จุดประสงคขอที่  2  ขอสอบที่ใชไดจํานวน  8  ขอ  คือขอที่  10, 11, 12, 13, 14, 15, 16, 17 
จุดประสงคขอที่  3  ขอสอบที่ใชไดจํานวน  12  ขอ  คือขอที่  18, 19, 20, 21, 22, 23, 24, 25, 27, 

29,30,31 
จุดประสงคขอที่  4  ขอสอบที่ใชไดจํานวน  12  ขอ  คือขอที่  32, 33, 34, 35, 36, 37, 38, 39, 40, 

41, 42, 43 
จุดประสงคขอที่  5  ขอสอบที่ใชไดจํานวน  10  ขอ  คือขอที่  45, 46, 47, 48, 49, 50, 51, 52, 

53, 54



ตาราง  18  แสดงคาความยาก (P) คาอาํนาจจาํแนก (r) และคาความเชื่อมั่น 
ของแบบทดสอบ  กอนและหลังการฝกอบรม 

ขอที่  P  r  การแปรผล 
1  0.20  0.40  นําไปใชได 
2  0.77  0.47  นําไปใชได 
3  0.60  0.40  นําไปใชได 
4  0.50  0.47  นําไปใชได 
5  0.67  0.40  นําไปใชได 
6  0.43  0.60  นําไปใชได 
7  0.57  0.47  นําไปใชได 
8  0.50  0.60  นําไปใชได 
9  0.47  0.93  นําไปใชได 
10  0.77  0.47  นําไปใชได 
11  0.67  0.40  นําไปใชได 
12  0.70  0.47  นําไปใชได 
13  0.67  0.53  นําไปใชได 
14  0.30  0.47  นําไปใชได 
15  0.63  0.47  นําไปใชได 
16  0.33  0.53  นําไปใชได 
17  0.50  0.47  นําไปใชได 
18  0.47  0.53  นําไปใชได 
19  0.40  0.40  นําไปใชได 
20  0.47  0.40  นําไปใชได 

คาความเชื่อมั่นเทากับ  0.874



ตาราง  19  แสดงคะแนนเปรียบเทียบกอนการฝกอบรมและหลังการฝกอบรม 

คนที่  คะแนนกอนฝกอบรม  คะแนนหลงัฝกอบรม 
1  4  14 
2  6  18 
3  7  16 
4  9  18 
5  4  17 
6  8  18 
7  7  16 
8  9  18 
9  4  16 
10  9  16 
11  6  14 
12  8  17 
13  4  17 
14  7  18 
15  9  15 
16  4  18 
17  9  16 
18  7  17 
19  8  16 
20  4  16 
21  9  17 
22  5  16 
23  8  18 
24  7  15 
25  5  18



ตาราง  19 (ตอ) 

คนที่  คะแนนกอนฝกอบรม  คะแนนหลงัฝกอบรม 
26  10  14 
27  9  18 
28  5  17 
29  8  16 
30  7  17 
เฉลี่ย  6.87  16.57



แบบทดสอบกอนการอบรม 
เรื่อง  การสรางหนังสืออิเล็กทรอนิกส 

คําชี้แจง  เลือกขอที่ถูกตองที่สุดเพียงขอเดียว 
1.  หนังสืออิเล็กทรอนิกส  หมายถึงขอใด 

ก.  มีรูปแบบของการจัดเกบ็และนําเสนอขอมูลทางอินเทอรเนต็ 
ข.  เปนเนื้อหาหรือเอกสารที่ถกูดัดแปลงอยูในระบบดจิิทัล  นาํเสนอขอมูลดวยสื่อหลายมิติ 
ค.  หนังสือที่มีลกัษณะพิเศษและตองอานผานทางอินเทอรเนต็เทานัน้ 
ง.  หนังสือทีเ่กี่ยวกับวงจรอิเล็กทรอนกิสแบบตาง ๆ 

2.  Hypertext คืออะไร 
ก.  ขอมูลที่มีขอความเปนตัวอักษรหรือตัวเลข 
ข.  ขอมูลที่มีขอความเปนตัวอักษรหรือตัวเลข  ภาพเคลื่อนไหว  ภาพนิ่งและเสียง 
ค.  แบบสื่อประสม 
ง.  ขอมูลที่เปนภาพนิง่และเสยีง 

3.  หนังสืออิเล็กทรอนิกสแบบ Text Book ไดแกขอใด 
ก.  หนังสือแบบตํารา  บรรจุขอมูลในรูปแบบตัวหนังสือ 
ข.  หนังสือภาพนิ่งชนิดไมมีเสยีง 
ค.  หนังสือภาพเคลื่อนไหว 
ง.  หนังสือเสยีงอาน 

4.  e-Book แตกตางจากหนังสือทั่วไปอยางไร 
ก.  สามารถยอนกลับเพื่อทบทวนบทเรียนหากไมเขาใจ 
ข.  สามารถเลือกเรยีนไดตามเวลาและสถานทีท่ี่ผูเรยีนสะดวก 
ค.  สามารถปรับเปลีย่น  แกไข  เพิ่มเติมขอมูลได 
ง.  สามารถแสดงทั้งขอความ  ภาพนิ่ง  ภาพเคลื่อนไหวและเสียงไดพรอมกัน 

5.  ขอใดไมใชขัน้ตอนของกระบวนการออกแบบ 
ก.  การวิเคราะห Analysis 
ข.  การสังเคราะห Synthesis 
ค.  การพัฒนา Development 
ง.  การประเมินผล Evaluation



6.  การศึกษาขอมูลของกลุมเปาหมาย  ดานอายุและเพศ  ตรงกับขอใด 
ก.  การวิเคราะหหลกัสูตร 
ข.  การวิเคราะหสภาพแวดลอมทีเ่กี่ยวกบัการเรยีน 
ค.  การวิเคราะหเนื้อหา 
ง.  การวิเคราะหผูเรียน 

7.  เนื้อหาขอใด  ไมเหมาะสําหรับสรางสื่อหนังสืออิเลก็ทรอนิกส 
ก.  สูตรคณิตศาสตร 
ข.  สถานที่ทองเทีย่ว 
ค.  สมาธิ 
ง.  กลวยตาก 

8.  การออกแบบหนาจอภาพ  หมายถึงขอใด 
ก.  การจัดพื้นที่ของจอภาพเพื่อใชในการนําเสนอเนื้อหา 
ข.  การจัดพื้นที่ของรูปภาพในเนื้อเรื่อง 
ค.  การเลือกรูปแบบและขนาดของตัวอักษรใหมีขนาดเล็ก 
ง.  การแบงคอลัมน 

9.  ขอใดคือคุณสมบัติของโปรแกรม DeskTop Author 
ก.  สรางแบบทดสอบ  แทรกลงในหนังสืออิเลก็ทรอนกิสได 
ข.  แทรกไฟลภาพเคลื่อนไหว  วีดิทัศน  หรือไฟลเสียงได 
ค.  มีเมนูคําสั่งอัพโหลดหนงัสืออิเล็กทรอนกิสขึ้นอินเทอรเน็ตได 
ง.  ถูกทุกขอ 

10.  คําส่ังใดทีใ่ชสําหรับสรางหนังสือเลมใหม 
ก.  New 
ข.  Save 
ค.  Package 
ง.  Page



11.  การกําหนดขนาดของหนาหนังสืออิเลก็ทรอนกิส  จะตองคํานึงถึงขอใดเปนหลัก 
ก.  ความละเอียดของจอแสดงผล 
ข.  เนื้อหาสาระของหัวเรื่องที่จะสราง 
ค.  ขนาดของภาพประกอบ 
ง.  ความพอใจของผูสราง 

12.  การกําหนดใหหนากระดาษของหนังสืออิเล็กทรอนิกส  เปนสีเดียวกนัตลอดทั้งเลม  ทําไดโดย 
วิธีใด 
ก.  ใชกลองเครื่องมือ  เลือกปุม  Insert Box  แลวเลือกสีตามตองการ 
ข.  ใชเมนู  Properties  แลวกําหนดสีของกระดาษที่ Paper Colour 
ค.  ใชกลองเครื่องมือ  เลือกปุม  Colour  แลวเลือกสีตามตองการ 
ง.  ใชเมนู  Template  แลวเลือกสีตามตองการ 

13.  ถาตองการสรางแบบทดสอบ ทานมีขัน้ตอนการสรางอยางไร 
ก.  EazyForm > Add Question 
ข.  EazyForm > Add Submit Button 
ค.  EazyForm > Edit Result Page 
ง.  EazyForm > Properties 

14.  การสรางขอสอบแบบเติมคํา ตองเลือกรูปแบบการสรางแบบทดสอบชนิดใด 
ก.  Input 
ข.  Text Area 
ค.  List 
ง.  Dropdown List 

15.  การสรางขอสอบแบบเลือกตอบ  5  ตัวเลือก  ทานสามารถกําหนดไดอยางไร 
ก.  ที่หนาตาง Eazy Form Editor กําหนดที่ Answer Type 
ข.  ที่หนาตาง Eazy Form Editor กําหนดที่ Number of Answers 
ค.  ที่หนาตาง Eazy Form Editor กําหนดที่ Answer Caption 
ง.  ที่หนาตาง Eazy Form Editor กําหนดที่ Correct Answer



16.  เมื่อคลิกปุม Submit Button ที่สรางแลว แตไมสามารถแสดงหนารายงานผลคะแนนตอง 
แกไขอยางไร 
ก.  คลิกปุม Edit Result Page ที่ Add form objects เพื่อกําหนดคณุสมบัตใิหม 
ข.  แกไขที่หนาตาง Button properties กําหนด Method ใหเปน No Information และ 

กําหนด Password 
ค.  แกไขที่หนาตาง Button properties กําหนด Method ใหเปน No Information และใส 

เครื่องหมายถูกที่  View Result 
ง.  แกไขที่หนาตาง Button properties กําหนด Method ใหเปน No Information และ 

กําหนด items sent เปน All 
17.  คําส่ัง Package ใชสําหรับทําอะไร 

ก.  บีบอัดไฟลงานทั้งหมดทีท่ําขึ้นมาใหรวมอยูในไฟลเดยีว 
ข.  สรางคําถามและเฉลยคําตอบ 
ค.  กําหนดคาตาง ๆ ของหนังสืออิเล็กทรอนิกสที่จัดทํา 
ง.  บันทึกไฟลงาน 

18.  เมื่อตองการใหหนงัสืออิเล็กทรอนกิสทีเ่ราสราง  มีขนาดไฟลเล็ก  เหมาะสําหรับเผยแพรบน 
เครือขายอินเทอรเนต็  ตองใชคําส่ังใด 
ก.  Package EXE 
ข.  Package DNL 
ค.  Package SCR 
ง.  Page 

19.  เมื่อตองการใหหนงัสืออิเล็กทรอนกิสทีเ่ราสรางไปใชบนเครื่องคอมพิวเตอรทั่วไป  ที่ไมเชื่อมตอ 
อินเทอรเน็ต  ตองใชคําส่ังใด 
ก.  Package EXE 
ข.  Package DNL 
ค.  Package SCR 
ง.  Package DRM



20.  โปรแกรม DeskTop Author สามารถสรางโปรแกรมรักษาหนาจอ (Screen Saver) โดยวิธีการ 
ในขอใด

ก.  Package DNL 
ข.  Package EXE 
ค.  Package SCR 
ง.  Package DRM



แบบทดสอบหนวยที่ 1 
เร่ือง  ความรูเบื้องตนเกีย่วกับหนังสืออิเล็กทรอนิกส 

คําชี้แจง  โปรดใสเครื่องหมาย  X  ทับขอที่ถกูตองที่สุดเพยีงขอเดียว 

1.  หนังสืออิเล็กทรอนิกส หมายถึงขอใด 
ก.  มีรูปแบบของการจัดเกบ็และนําเสนอขอมูลทางอินเทอรเน็ต 
ข.  เปนเนื้อหาหรือเอกสารที่ถูกดัดแปลงอยูในระบบดิจทิัล นําเสนอขอมูลดวยสื่อหลายมติิ 
ค.  หนังสือที่มีลักษณะพเิศษและตองอานผานทางอินเทอรเน็ตเทานัน้ 
ง.  หนังสือที่เกี่ยวกบัวงจรอิเลก็ทรอนิกสแบบตาง ๆ 

2.  Hypermedia  คืออะไร 
ก.  ขอมูลที่มีขอความเปนตัวอักษร หรือตัวเลข 
ข.  ขอมูลที่มีขอความเปนตัวอักษร หรือตัวเลข  ภาพเคลื่อนไหว ภาพนิ่ง 
ค.  สื่อประสม 
ง.  ขอมูลที่เปนภาพนิ่งและเสียง 

3.  หนังสืออิเล็กทรอนกิสประเภทใดที่มีเนื้อหาประกอบดวย ขอความ เสียง รูปภาพ วิดีทัศน 
ก.  Talking Books 
ข.  Moving Picture Books 
ค.  Multimedia Books 
ง.  Telemedia Books 

4.  e-Book ประเภทใดเหมาะสําหรับใชเปนสื่อการเรยีนรูในวิชาชางยนตมากที่สุด 
ก.  Cyberspace Books 
ข.  Intelligent Electronic Books 
ค.  Talking Books 
ง.  Telemedia Books 

5.  โครงสรางรูปแบบใดของ e-Book ที่เหมาะสําหรับผูเรียนที่มีประสบการณดานเนื้อหามาแลว 
ก.  แบบเสนตรง 
ข.  แบบเว็บ 
ค.  แบบสาขา 
ง.  แบบตาขาย



แบบทดสอบหนวยที่ 2 
เร่ือง  การออกแบบและพัฒนาหนังสืออิเล็กทรอนิกส 

คําชี้แจง  โปรดใสเครื่องหมาย  X  ทับขอที่ถกูตองที่สุดเพยีงขอเดียว 

1.  การศึกษาขอมูลของกลุมเปาหมาย  ดานอายุ  และเพศ  ตรงกับขอใด 
ก.  การวิเคราะหหลกัสูตร 
ข.  การวิเคราะหสภาพแวดลอมที่เกีย่วกับการเรียน 
ค.  การวิเคราะหเนื้อหา 
ง.  การวิเคราะหผูเรยีน 

2.  ขอใดไมใชประโยชน หรือความสําคัญของการเขียนสคริปต และบทนําเรื่อง 
ก.  ทราบจุดเริ่มตนและจุดสิ้นสดุของเนื้อหาบทเรียน 
ข.  แสดงวิธีการดําเนินบทเรียนและวิธกีารนําเสนอเนื้อหา 
ค.  บงบอกประสิทธิภาพและคณุภาพของสื่อ 
ง.  แสดงความสัมพันธเชื่อมโยงของเนื้อหา 

3.  เนื้อหาที่นํามาออกแบบในรปูของบทเรียนอเิล็กทรอนกิสควรเปนเนื้อหาประเภทใด 
ก.  ประเภทเนนการทองจําและทกัษะทางปญญา 
ข.  เปนเนื้อหาทางดานทกัษะรางกาย มากกวาทกัษะทางปญญา 
ค.  เปนเนื้อหาประเภทเจตคติมากกวาการทองจํา 
ง.  เปนเนื้อหาทางทักษะทางปญญาและประเภทเจตคติ 

4.  องคประกอบขอใดสําคญัที่สดุ 
ก.  รูปภาพ 
ข.  ขอความ 
ค.  เสียง 
ง.  ภาพเคลื่อนไหว 

5.  มนุษยเรยีนรูจากขอใดมากที่สุด 
ก.  การอาน 
ข.  การฟง 
ค.  การมองเห็น 
ง.  การมองเห็นและการไดยิน



แบบทดสอบหนวยที่ 3 
เร่ือง  การสรางหนังสืออิเลก็ทรอนิกส ดวยโปรแกรม DeskTop Author 

คําชี้แจง  โปรดใสเครื่องหมาย  X  ทับขอที่ถกูตองที่สุดเพยีงขอเดียว 

1.  คําส่ังใดที่ใชสําหรับสรางหนังสือเลมใหม 
ก.  New 
ข.  Save 
ค.  Package 
ง.  Page 

2.  การแทรกขอความใชคําส่ังขอใด 
ก.  Edit > Paste 
ข.  Insert > Box 
ค.  Insert > Text 
ง.  Insert > Image 

3.  การแทรกภาพนิ่ง ใชคําส่ังขอใด 
ก.  Edit > Paste 
ข.  Insert > Box 
ค.  Insert > Text 
ง.  Insert > Image 

4.  การกําหนดขนาดของหนาหนงัสือ ใชคําส่ัง ขอใด 
ก.  EazyForm 
ข.  Template 
ค.  Publish 
ง.  Properties 

5.  การกําหนดสใีหโปรงใส ไมแสดงภาพ ในการทําปกหนา ปกหลัง กําหนดโดยวิธีขอใด 
ก.  ใชเมนู Properties แลวเลือก Background Colour 
ข.  ใชเมนู Tools แลวเลือก Book Transparency 
ค.  ใชกลองเครื่องมือ Tools เลือก Insert Box แลวเลือกสีขาว 
ง.  ใชกลองเครื่องมือ Tools เลือก Colour



6.  ขอใดตอไปนี้กลาวถึงการกําหนดการเชื่อมโยง  จากปุมที่เรานํามาใสไวในหนาของหนังสือ 
อิเล็กทรอนิกสใหเชื่อมโยงไปยังหนาปกของหนังสือ  ไมถูกตอง 
ก.  กลองเครื่องมือ  เลือก Change Link กําหนด Link Type เปน Page กําหนด 

Link Target เปน  1 
ข.  คลิกขวาที่ปุม  เลือก Change Link กําหนด Link Type เปน Page กําหนด Link Target 

เปน  1 
ค.  คลิกเมนู Tools เลือก Link Edit กําหนด Link Type เปน Page กําหนด Link Target 

เปน 1 
ง.  ดับเบิลคลกิที่ปุม  เลือก Change Link กําหนด Link Type เปน Page กําหนด Link 

Target เปน  1 
7.  การกําหนดจุดเชื่อมโยงไปยังเว็บไซตภายนอก  ตองกรอกขอมูลในขอใด 

ก.  Password 
ข.  e-Mail Address 
ค.  User Name 
ง.  URL 

8.  ถาตองการใหเพลง  เลนวนแบบตอเน่ือง  ตองคลกิเลือกคาํสั่งใด 
ก.  Embed file inside book 
ข.  Start play automatically 
ค.  Loop 
ง.  Show controls 

9.  หากตองการสรางหนังสืออิเล็กทรอนิกส  ที่ผูใชสามารถพิมพขอมูลแกไขเพิ่มเติมไดตองใชขอใด 
ก.  Insert Text 
ข.  Insert Editable Text 
ค.  Insert Editable Image 
ง.  Insert Pop Image



10.  เมื่อตองการเปดไฟลงานหนังสืออิเล็กทรอนิกสที่เราสรางขึ้นมาเพื่อแกไข ปรับปรุงตองเลือก 
ไฟลที่มีสวนขยายหรือนามสกุลใด 

ก.  .exe 
ข.  .dnl 
ค.  .dml 
ง.  .scr



แบบทดสอบหนวยที่ 4 
เร่ือง  การสรางแบบทดสอบ 

คําชี้แจง  โปรดใสเครื่องหมาย  X  ทับขอที่ถกูตองที่สุดเพยีงขอเดียว 

1.  ถาตองการสรางแบบทดสอบ ทานมีขัน้ตอนการสรางอยางไร 
ก.  EazyForm > Add Question 
ข.  EazyForm > Add Submit Button 
ค.  EazyForm > Edit Result Page 
ง.  EazyForm > Properties 

2.  การสรางแบบทดสอบ สามารถกําหนดไดกี่รูปแบบ 
ก.  2 แบบ 
ข.  4 แบบ 
ค.  6 แบบ 
ง.  8 แบบ 

3.  การสรางขอสอบแบบเติมคํา ตองเลือกรูปแบบการสรางแบบทดสอบชนิดใด 
ก.  Input 
ข.  Text Area 
ค.  List 
ง.  Dropdown List 

4.  การสรางขอสอบดวยโปรแกรม DeskTop Author สามารถสรางคําถามในขอสอบแตละชุดได 
สูงสุดกี่ขอ 
ก.  200 ขอ 
ข.  150 ขอ 
ค.  100 ขอ 
ง.  ไมจํากัดจํานวนขอ



5.  การสรางขอสอบชนิดเลือกตอบ แบบ List สามารถกําหนดตัวเลือกสูงสุด ไดกี่ตัวเลือก 
ก.  100 ขอ 
ข.  150 ขอ 
ค.  200 ขอ 
ง.  ไมจํากัดจํานวนขอ 

6.  การสรางขอสอบแบบเลือกตอบ 5 ตัวเลือก ทานสามารถกําหนดไดอยางไร 
ก.  ที่หนาตาง Eazy Form Editor กําหนดที่ Answer Type 
ข.  ที่หนาตาง Eazy Form Editor กําหนดที่ Number of Answers 
ค.  ที่หนาตาง Eazy Form Editor กําหนดที่ Answer Caption 
ง.  ที่หนาตาง Eazy Form Editor กําหนดที่ Correct Answer 

7.  การสรางขอสอบแบบ Radio Box สามารถเลือกคําตอบที่ถูกไดกี่ขอ 
ก.  1 ขอ 
ข.  2 ขอ 
ค.  3 ขอ 
ง.  4 ขอ 

8.  การสรางปุมสําหรับการตรวจสอบผลคะแนนในการทําขอสอบ มีข้ันตอนอยางไร 
ก.  EazyForm > Add Question 
ข.  EazyForm > Add Submit Button 
ค.  EazyForm > Edit Result Page 
ง.  EazyForm > Page 

9.  ถาตองการกําหนดคณุสมบัติปุม Submit Button สามารถทําไดอยางไร 
ก.  เลือกปุม > คลิกขวา > เลือก Change Position 
ข.  เลือกปุม > คลิกขวา > เลือก Properties Button 
ค.  เลือกปุม > คลิกขวา > เลือก Add Submit Button 
ง.  เลือกปุม > คลิกขวา > เลือก Change Properties



10.  การสรางหนารายงานผลคะแนนสามารถทําไดอยางไร 
ก.  EazyForm > Add Question 
ข.  EazyForm > Add Submit Button 
ค.  EazyForm > Edit Result Page 
ง.  EazyForm > Page



แบบทดสอบหนวยที่ 5 
เร่ือง  การนําไฟลหนังสืออิเล็กทรอนิกสไปใชงาน 

คําชี้แจง  โปรดใสเครื่องหมาย  X  ทับขอที่ถกูตองที่สุดเพยีงขอเดียว 

1.  คําส่ัง Package ใชสําหรบัทําอะไร 
ก.  บีบอัดไฟลงานทั้งหมดทีท่ําขึ้นมาใหรวมอยูในไฟลเดยีว 
ข.  สรางคําถามและเฉลยคําตอบ 
ค.  กําหนดคาตาง ๆ  ของหนังสืออิเล็กทรอนิกสทีจ่ัดทํา 
ง.  บันทึกไฟลงาน 

2.  เมื่อตองการใหหนังสืออิเล็กทรอนิกสทีเ่ราสราง  มีขนาดไฟลเล็ก  เหมาะสําหรับเผยแพรบน 
เครือขายอินเทอรเน็ต  ตองใชคําส่ังใด 
ก.  Package EXE 
ข.  Package DNL 
ค.  Package SCR 
ง.  Package Page 

3.  เมื่อตองการใหหนังสืออิเล็กทรอนิกสทีเ่ราสรางไปใชบนเครื่องคอมพิวเตอรทั่วไป  ที่ไมเชื่อมตอ 
อินเทอรเน็ต  ตองใชคําส่ังใด 
ก.  Package EXE 
ข.  Package DNL 
ค.  Package SCR 
ง.  Package DRM 

4.  คําส่ัง Publish ใชสั่งงานขอใด 
ก.  สั่งพิมพหนังสืออิเลก็ทรอนกิส 
ข.  สั่งพิมพหนังสืออิเลก็ทรอนกิสผานระบบเครือขาย 
ค.  จัดเก็บไฟลหนังสืออิเล็กทรอนิกสใหอยูในรูปแบบ .exe 
ง.  จัดเก็บไฟลหนังสืออิเล็กทรอนิกสใหอยูในรูปแบบ .html



5.  หากตองการกําหนดใหไฟลหนังสืออิเล็กทรอนิกส  อยูในรูปแบบ .dml จะตองใชคําส่ังใด 
ก.  Save 
ข.  Package 
ค.  Upload 
ง.  Page 

6.  เมื่อตองการใหหนังสืออิเล็กทรอนิกสทีเ่ราสราง  มีระบบการปองกันสทิธิ์  เหมาะสําหรับพัฒนา 
เปนธุรกิจตองใชคําส่ังใด 

ก.  Package DRM 
ข.  Package DNL 
ค.  Package EXE 
ง.  Package SCR 

7.  กอนใชคําส่ัง Publish จะตองทําขั้นตอนใดกอน 
ก.  Package EXE 
ข.  Package DNL 
ค.  Package DRM 

ง.  Package SCR 

8.  การเก็บบันทึกหนังสืออิเล็กทรอนิกสในขอใด  สามารถนํามาแกไขเพิ่มเติมขอมูลภายหลังได 
ก.  .dnl 
ข.  .drm 

ค.  .exe 
ง.  .dml 

9.  โปรแกรม DeskTop Author สามารถสรางโปรแกรมรักษาหนาจอ (Screen Saver) โดยวิธีการ 
ในขอใด

ก.  Package DNL 
ข.  Package EXE 
ค.  Package DRM 

ง.  Package SCR



10. การเผยแพรหนังสืออิเลก็ทรอนกิส ไปยังผูใชที่มเีครื่องคอมพิวเตอรแบบ Stand Alone 
ดวยวิธีใดเหมาะสมที่สดุ 

ก.  แนบไฟล e­Mail 

ข.  บันทึกลงแผนซดี-ีรอม (CD­ROM) 
ค.  บริการดาวนโหลด (Download) จากเว็บไซต 
ง.  นําเสนอทางหนาเว็บเพจ



แบบทดสอบหลังการอบรม 
เร่ือง  การสรางหนังสืออิเลก็ทรอนิกส 

คําชี้แจง  โปรดใสเครื่องหมาย  X  ทับขอที่ถกูตองที่สุดเพยีงขอเดียว 

1.  โปรแกรม DeskTop Author สามารถสรางโปรแกรมรักษาหนาจอ (Screen Saver) โดยวิธีการ 
ในขอใด 
ก.  Package DNL 
ข.  Package EXE 
ค.  Package SCR 
ง.  Package DRM 

2.  เมื่อตองการใหหนังสืออิเล็กทรอนิกสทีเ่ราสรางไปใชบนเครื่องคอมพิวเตอรทั่วไป  ที่ไมเชื่อมตอ 
อินเทอรเน็ต  ตองใชคําส่ังใด 

ก.  Package EXE 
ข.  Package DNL 
ค.  Package SCR 
ง.  Package DRM 

3.  เมื่อตองการใหหนังสืออิเล็กทรอนิกสทีเ่ราสราง  มีขนาดไฟลเล็กเหมาะสําหรับเผยแพร 
บนเครือขายอินเทอรเน็ต  ตองใชคําส่ังใด 

ก.  Package EXE 
ข.  Package DNL 
ค.  Package SCR 
ง.  Page 

4.  คําส่ัง Package ใชสําหรับทําอะไร 
ก.  บีบอัดไฟลงานทั้งหมดทีท่ําขึ้นมาใหรวมอยูในไฟลเดยีว 
ข.  สรางคําถามและเฉลยคําตอบ 
ค.  กําหนดคาตาง ๆ  ของหนังสืออิเล็กทรอนิกสทีจ่ัดทํา 
ง.  บันทึกไฟลงาน



5.  เมื่อคลิกปุม Submit Button ที่สรางแลว แตไมสามารถแสดงหนารายงานผลคะแนน ตองแกไข 
อยางไร 

ก.  คลิกปุม Edit Result Page ที่ Add form objects เพื่อกําหนดคณุสมบัตใิหม 
ข.  แกไขที่หนาตาง Button properties กําหนด Method ใหเปน No Information และ 

กําหนด Password 
ค.  แกไขที่หนาตาง Button properties กําหนด Method ใหเปน No Information และใส 

เครื่องหมายถูกที่ View Result 
ง.  แกไขที่หนาตาง Button properties กําหนด Method ใหเปน No Information และ 

กําหนด items sent เปน All 
6.  การสรางขอสอบแบบเลือกตอบ 5 ตัวเลือก ทานสามารถกําหนดไดอยางไร 

ก.  ที่หนาตาง Eazy Form Editor กําหนดที่ Answer Type 
ข.  ที่หนาตาง Eazy Form Editor กําหนดที่ Number of Answers 
ค.  ที่หนาตาง Eazy Form Editor กําหนดที่ Answer Caption 
ง.  ที่หนาตาง Eazy Form Editor กําหนดที่ Correct Answer 

7.  การสรางขอสอบแบบเตมิคํา  ตองเลือกรูปแบบการสรางแบบทดสอบชนิดใด 
ก.  Input 
ข.  Text Area 
ค.  List 
ง.  Dropdown List 

8.  ถาตองการสรางแบบทดสอบ ทานมีขั้นตอนการสรางอยางไร 
ก.  EazyForm > Add Question 
ข.  EazyForm > Add Submit Button 
ค.  EazyForm > Edit Result Page 
ง.  EazyForm > Properties



9.  การกําหนดใหหนากระดาษของหนังสืออิเล็กทรอนิกส เปนสเีดียวกันตลอดทัง้เลม ทําไดโดย 
วิธีใด 
ก.  ใชกลองเครื่องมือ เลือกปุม Insert Box แลวเลือกสีตามตองการ 
ข.  ใชเมนู Properties แลวกําหนดสีของกระดาษที่ Paper Colour 
ค.  ใชกลองเครื่องมือ เลือกปุม Colour แลวเลือกสีตามตองการ 
ง.  ใชเมนู Template แลวเลือกสีตามตองการ 

10.  การกําหนดขนาดของหนาหนังสืออิเลก็ทรอนกิส จะตองคํานึงถึงขอใดเปนหลัก 
ก.  ความละเอียดของจอแสดงผล 
ข.  เนื้อหาสาระของหัวเรื่องที่จะสราง 
ค.  ขนาดของภาพประกอบ 
ง.  ความพอใจของผูสราง 

11.  คําส่ังใดทีใ่ชสําหรับสรางหนังสือเลมใหม 
ก.  New 
ข.  Save 
ค.  Package 
ง.  Page 

12.  ขอใดคือคุณสมบตัิของโปรแกรม DeskTop Author 
ก.  สรางแบบทดสอบ แทรกลงในหนังสืออิเล็กทรอนกิสได 
ข.  แทรกไฟลภาพเคลื่อนไหว วีดิทศัน หรือไฟลเสยีงได 
ค.  มีเมนูคําสั่งอัพโหลดหนงัสืออิเล็กทรอนกิส ข้ึนอินเทอรเน็ตได 
ง.  ถูกทุกขอ 

13.  การออกแบบหนาจอภาพ หมายถึงขอใด 
ก.  การจัดพื้นที่ของจอภาพเพื่อใชในการนําเสนอเนื้อหา 
ข.  การจัดพื้นที่ของรูปภาพในเนื้อเรื่อง 
ค.  การเลือกรูปแบบและขนาดของตัวอักษรใหมีขนาดเล็ก 
ง.  การแบงคอลัมน



14.  เนื้อหาขอใด ไมเหมาะสําหรับสรางสื่อหนังสืออิเล็กทรอนิกส 
ก.  สูตรคณิตศาสตร 
ข.  สถานที่ทองเทีย่ว 
ค.  สมาธิ 
ง.  ลางสาด 

15.  การศึกษาขอมูลของกลุมเปาหมาย ดานอายุและเพศ ตรงกับขอใด 
ก.  การวิเคราะหหลกัสูตร 
ข.  การวิเคราะหสภาพแวดลอมทีเ่กี่ยวกบัการเรยีน 
ค.  การวิเคราะหเนื้อหา 
ง.  การวิเคราะหผูเรียน 

16.  ขอใดไมใชขัน้ตอนของกระบวนการออกแบบ 
ก.  การวิเคราะห Analysis 
ข.  การสังเคราะห Synthesis 
ค.  การพัฒนา Development 
ง.  การประมวลผล Evaluation 

17.  e-Book แตกตางจากหนังสือทั่วไปอยางไร 
ก.  สามารถยอนกลับเพื่อทบทวนบทเรียนหากไมเขาใจ 
ข.  สามารถเลือกเรยีนไดตามเวลาและสถานทีท่ี่ผูเรยีนสะดวก 
ค.  สามารถปรับเปลีย่น แกไข เพิ่มเติมขอมูลได 
ง.  สามารถแสดงทั้งขอความ ภาพนิ่ง ภาพเคลื่อนไหวและเสยีง ไดพรอมกัน 

18.  หนังสืออิเล็กทรอนิกสแบบ Text Book ไดแกขอใด 
ก.  หนังสือแบบตํารา บรรจุขอมูลในรูปแบบตัวหนังสือ 
ข.  หนังสือภาพนิ่งชนิดไมมีเสยีง 
ค.  หนังสือภาพเคลื่อนไหว 
ง.  หนังสือเสยีงอาน



19.  Hypertext คืออะไร 
ก.  ขอมูลที่มีขอความเปนตัวอักษรหรือตัวเลข 
ข.  ขอมูลที่มีขอความเปนตัวอักษรหรือตัวเลข ภาพเคลื่อนไหว ภาพนิ่งและเสียง 
ค.  สื่อประสม 
ง.  ขอมูลที่เปนภาพนิง่และเสยีง 

20.  หนังสืออิเล็กทรอนิกส หมายถึงขอใด 
ก.  มีรูปแบบของการจัดเกบ็และนําเสนอขอมูลทางอินเทอรเนต็ 
ข.  เปนเนื้อหาหรือเอกสารที่ถกูดัดแปลงอยูในระบบดจิิทัล นําเสนอขอมูลดวยสื่อหลายมิติ 
ค.  หนังสือที่มีลกัษณะพิเศษและตองอานผานทางอินเทอรเนต็เทานัน้ 
ง.  หนังสือทีเ่กี่ยวกับวงจรอิเล็กทรอนกิสแบบตาง ๆ



ภาคผนวก  ฉ 

แผนผังโครงสรางของเว็บฝกอบรม  เร่ืองการสรางหนังสืออิเล็กทรอนิกส 
สําหรับครูผูสอน  สังกัดสํานักงานเขตพื้นท่ีการศกึษาพิษณุโลก  เขต 1



ภาคผนวก  ฉ 

ภาพ  11  แผนผังโครงสรางของเว็บฝกอบรม  เรื่อง  การสรางหนังสืออิเล็กทรอนิกส 
สําหรับครูผูสอน  สังกัดสํานกังานเขตพื้นที่การศกึษาพิษณุโลก  เขต  1 

สมัครอบรม 

หนาแรก 

ปฐมนิเทศ 

การใชงาน 

แผนผังเว็บไซต 

ลงทะเบียน ลงทะเบียน 

หลักสูตรอบรม 

แบบทดสอบกอนการอบรม 

เคร่ืองมืออบรม 

1. ความรูเบื้องตนเกี่ยวกับหนังสือ 

2. การออกแบบและพัฒนาหนังสือ 

3. การสรางหนังสืออิเล็กทรอนิกสดวย 
DeskTop Author 

4. การสรางแบบทดสอบ 

5. การนําไฟลหนังสืออิเล็กทรอนิกสไปใชงาน 

แบบทดสอบหลังการอบรม 

สมุดรายงาน 

สงขอความ 

ตารางนัดหมาย 

สมุดบันทึก 

แกไขขอมูล 

ออกจากระบบ 

กระดานขาว 

เพื่อนรวมอบรม 

ผูจัดทํา



ภาพ  12  แผนผังโครงสรางของบทเรียนหนวยที่  1 

หนวยที่ 1 ความรูเบื้องตนเกี่ยวกับหนังสืออิเล็กทรอนิกส 

บทนํา 

ความหมายของหนังสืออิเลก็ทรอนกิส 

ประเภทของหนังสืออิเล็กทรอนิกส 

ลักษณะของหนังสืออิเล็กทรอนิกส 

รูปแบบของหนังสืออิเลก็ทรอนกิส 

องคประกอบของหนังสืออิเลก็ทรอนกิส 

โครงสรางของหนังสืออิเล็กทรอนิกส 

จุดเดน-จุดดอย ของหนังสืออิเล็กทรอนิกส 

ประโยชนของหนังสืออิเล็กทรอนิกส 

แบบทดสอบทายหนวย



ภาพ  13  แผนผังโครงสรางของบทเรียนหนวยที่ 2 

หนวยที่ 2 การออกแบบและพฒันาหนังสืออิเล็กทรอนิกส 

กระบวนการออกแบบ 

องคประกอบดานกระบวนการสรางและพัฒนา 
หนังสืออิเล็กทรอนิกส 

การออกแบบเนื้อหา 

การออกแบบหนาจอภาพ 

สื่อมัลติมีเดีย 

แบบทดสอบทายหนวย



หนวยที่ 3 การสรางหนังสืออิเล็กทรอนิกส ดวยโปรแกรม DeskTop Author 

แนะนําโปรแกรม DeskTop Author 

การติดตั้งโปรแกรม DeskTop Author 

การใชงานโปรแกรม DeskTop Author 

ขั้นตอนการสรางหนังสืออิเล็กทรอนิกส 

การสรางปกหนังสืออิเล็กทรอนิกส 

การแทรกขอความ 

การแทรกรูปภาพ 

การแทรกไฟลมัลติมีเดีย 

การแทรกปุมเมนู 

การเพิ่มหนาเอกสาร 

การลบหนาเอกสาร 

การใชพืน้หลังสําเร็จรูป 

การสรางจุดเชื่อมโยง 

แบบทดสอบทายหนวย 

ภาพ  14  แผนผังโครงสรางของบทเรียนหนวยที่ 3



หนวยที่ 4 การสรางแบบทดสอบ 

การสรางแบบทดสอบ 

การสรางแบบทดสอบ แบบ Input 

การสรางแบบทดสอบ แบบ Text Area 

การสรางแบบทดสอบ แบบ List 

การสรางแบบทดสอบ แบบ Dropdown List 

การสรางแบบทดสอบ แบบ Radio Box 

การสรางแบบทดสอบ แบบ Check Box 

การสรางปุมแสดงผลคะแนน Submit Button 

การสรางแบบทดสอบ แบบ Result Page 

แบบทดสอบทายหนวย 

ภาพ  15  แผนผังโครงสรางของบทเรียนหนวยที่ 4



หนวยที่ 5 การนําไฟลหนังสืออิเล็กทรอนิกสไปใชงาน 

การจัดเก็บไฟลหนังสืออิเล็กทรอนิกส 

การจัดเก็บไฟลแบบ Package EXE 

การจัดเก็บไฟลแบบ Package DNL 

การจัดเก็บไฟลแบบ Package DRM 

การจัดเก็บไฟลแบบ Package SCR 

การจัดเก็บไฟลแบบ Package EXE DNL DRM 

การ Publish 

การอัพโหลดไฟล Upload 

แบบทดสอบทายหนวย 

ภาพ  16  แผนผังโครงสรางของบทเรียนหนวยที่  5



ภาคผนวก  ช 

คูมือการใชเว็บฝกอบรม  เรื่อง  การสรางหนังสืออิเล็กทรอนิกส 
สําหรับครูผูสอน  สังกัดสํานักงานเขตพื้นท่ีการศึกษาพิษณุโลก  เขต  1



ภาคผนวก  ช 
คูมือการใชงานเว็บฝกอบรม เรื่อง การสรางหนังสืออิเล็กทรอนิกส 

การใชงานเว็บฝกอบรม  และการใชอุปกรณสนับสนนุการอบรมที่มีในระบบ 

1. หนาจอหลัก 
เมื่อผูเขาอบรมเขามาสูหนาโฮมเพจ  จะพบหนาจอหลกัดังรูป  ซึ่งประกอบดวยเมนูบาร 

ดานบน  และเฟรมเนื้อหาหลักดานลาง  เมนูบารจะปรากฎทุกหนาในระบบ  โดยมีสวนประกอบบน 
เมนูบาร  ไดแก 

1. หนาหลัก  แสดงหนาแรกของระบบ 
2. รายวิชา  แสดงเนื้อหาหลักสูตรที่เปดสอน 
3. ปฐมนิเทศ  แนะนําชี้แจงเกีย่วกับขอบขายการอบรมโดยสังเขป 
4. การใชงาน  แสดงขั้นตอนการอบรมและแนะนําเครื่องมอืสนับสนุนการอบรม 
5. แผนผังเว็บไซต  แสดงโครงสรางของเวบ็ไซต 
6. ผูจัดทํา  แสดงรายละเอียดเกีย่วกับคณะผูจัดทํา



สําหรับเฟรมเนื้อหาหลักดานลาง  จะประกอบดวย  3  สวน  คือ 
1. กรอบซายมือ  เปนสวนเครื่องมือการอบรม 
2. กรอบกลาง  เปนสวนเนื้อหาการอบรม 
3. กรอบขวามือ  เปนสถิติและขอมูลขาวสารจากวิทยากรและผูดูแลระบบ 

กรอบเคร่ืองมือการอบรม  เปนกรอบสําหรับใหผูใชทําการ Login เขาสูระบบ  หลังจาก 
ทําการ Login แลว กรอบนี้จะเปลี่ยนไปแสดงการเชื่อมโยงกับหนาเครื่องมือการอบรมตาง ๆ



2. การสมัครเขาอบรม 
วิธีการสมัครเขาเปนผูอบรมในเว็บฝกอบรม  เรื่อง  การสรางหนังสืออิเล็กทรอนิกสนี้ 

สามารถทําได  2  วิธีคือ  สมัครดวยตนเอง  หรือใหวทิยากรผูดูแลระบบเปนผูดําเนินการสมัครให 

ขั้นตอนการสมัครอบรม มดีังน้ี 
1. คลิกที่  สมัครเรียนฟรี  ในกรอบเครื่องมือการอบรม 
2. กรอกชื่อเขาอบรม 
3. กรอกรหัสผานและยืนยันรหัสผาน  ซึ่งขอมูลทั้งสองจะตองเหมือนกนั 
4. กรอกเลขประจําตัว 
5. คลิกที่ปุมสมัครสมาชกิ 

หลังจากสมคัรเขาอบรมแลว  ผูเขาอบรมสามารถใชชื่อและรหัสผานในการเขาสูระบบไดทันที



3. การ Login เขาอบรม 

วิธีการ Login เขาสูระบบเว็บฝกอบรม  มีขั้นตอนดังนี้ 
1. กรอกชื่อเขาอบรม 
2. กรอกรหัสผาน 
3. คลิกที่ปุม Login 

4. เคร่ืองมือการอบรม 

เมื่อผูอบรมเขามาในระบบ  กรอบเครื่องมือการอบรม 
จะแสดงเมนูหลกั  สําหรับใชงาน  6  รายการ  คือ 
สมุดรายงาน  สงขอความ  ตารางนัดหมาย  สมุดบันทึก 
แกไขขอมูลสวนตัว  และออกจากระบบ



4.1 สมุดรายงาน 
สมุดรายงานของผูเขาอบรมแตละคน  จะประกอบดวย  4  สวน  ดังรูป 

1. แสดงรายชื่อหลักสูตรที่ผูเขาอบรมกําลังเรียน 
2. แสดงรายชื่อหลักสูตรที่ผูเขาอบรม  ไดผานการอบรมแลว 
3. แสดงรายชื่อหลักสูตรที่ผูเขาอบรม  เรียนแลวไมผาน 
4. แสดงรายชื่อหลักสูตรที่ผูเขาอบรมพักการเรียน



4.2  สงขอความ 
เว็บฝกอบรม  เรื่อง  การสรางหนังสืออิเล็กทรอนิกส  มีเครือ่งมือสงขอความใหผูเขาอบรม 

สามารถติดตอส่ือสารกันภายในระบบ  ผานทาง e-Mail 
เมื่อผูเขาอบรมเขาสูหนา “สงขอความ” จะพบเครื่องมือ  ดงัรูป 

การสงขอความ  มีขั้นตอนการใชงาน  ดังนี้ 
1. ชอง “ชื่อเลน” สําหรับใสชื่อผูรวมอบรมคนอื่นที่ตองการติดตอดวย  ซึ่งสามารถตรวจ 
สอบและคนหาได  โดยการคลิกที่ปุม “Find a nickname” 

2. ชอง “Subject” สําหรับใสหัวขอของขอความที่ตองการสง 
3. ปุม  เลือกระดับความสําคัญมี  3  ระดับ  คือ  High, Normal  และ Low เมื่อเลือก 
ระดับความสําคัญ  รูปสัญลักษณที่อยูตรงดานหนาของปุม  จะไปปรากฎในตูรับ 
จดหมายของผูรับ 

4. ชอง “Message” สําหรับกรอกขอความที่ตองการสง 
5. เมื่อกรอกขอมูลทุกอยางแลวกดปุม “Send Message” ดานลาง ขอความจะถูกสงไปยัง 
ผูรับ  และถูกนําไปเก็บอยูใน “ขอความที่สง”



4.3  ตารางนัดหมาย 
ตารางนัดหมายเปนเครื่องมือ  ชวยจดบนัทกึนัดหมายหรือกําหนดการตาง ๆ  ดังรูป 

ผูเขาอบรมสามารถเลือกดูตารางได  4  รูปแบบ  คือ 
1. แบบรายวัน 
2. แบบรายสัปดาห 
3. แบบรายเดือน 
4. แบบรายป 
5. เมื่อตองการเพิ่มการนดัหมาย  กดปุม “เพิ่มนัดหมาย”



4.4 สมุดบันทึก 
ผูเขาอบรมสามารถทําการจดบันทึกออนไลน  รวมทั้งจัดการขอมูลตาง ๆ  ใหเปนหมวดหมู 

ไดอยางอิสระในหนาสมดุบันทึก  มีขั้นตอนดังนี้ 
1. คลิกที่บันทกึขอความ 
2. ใสหัวขอที่จะบนัทึก 
3. ใสขอความที่ตองการบันทกึ 
4. เลือกแฟมที่ตองการบนัทึก 
5. กดปุม SAVE



4.5 การแกไขขอมูลสวนตัว 
ผูเขาอบรมสามารถแกไขขอมูลสวนตัว  และรหัสผานของตนเอง  ตามข้ันตอนดังนี้ 

1. ถาตองการแกไขรหัสผาน  ใหกรอกรหัสผานใหม  โดยตองกรอกใหเหมือนกัน 
2. กรอกชื่อ และนามสกุล 
3. สามารถคลิกเลือก  รูปการตูนแทนตัวเองได 
4. กรอกหมายเลข  ICQ (ถามี) 
5. กรอกขอมูลเพิ่มเติม เชน ที่อยู เบอรโทรศพัท เปนตน 
6. คลิกที่ปุม  Save Changes 

หมายเหตุ 
ผูเรียนไมสามารถเปลี่ยนแปลง  ชื่อเขาอบรม  ที่ใชสําหรับ Login  และเลขประจําตัว



4.6 การออกจากระบบ 
เมื่อเสร็จสิน้การใชงานของระบบ  ผูเขาอบรมสามารถออกจากระบบ (Logout) โดยคลิกที่ 

“ออกจากระบบ” ในกรอบเครื่องมือการอบรม 

5. การอบรม 
ผูเขารับการอบรมจะตองทราบเกี่ยวกบัหัวขอทีเ่กี่ยวของ  ซึ่งมีรายละเอียดดังนี้ 
5.1 องคประกอบของหลักสูตร 
ผูเขาอบรมสามารถเรียกดูรายชื่อหลักสูตรที่เปดอบรม  โดยการคลิกที่  “รายวชิา” 

ที่เมนบูารดานบน  ดังที่ไดกลาวแลวในหัวขอหนาจอหลัก  รายชื่อหลักสูตรจะปรากฎ  ดังรูป 

เมื่อผูเขาอบรมสามารถคลิกที่ชื่อของหลกัสูตร  จะปรากฏแท็บรายการดังนี้ 

เน้ือหา 
แท็บเนื้อหา  จะแสดงรายละเอียดของเนื้อหาการอบรม  เชน  ชื่อหลักสูตร  ผูสรางหลกัสูตร 

ระยะเวลา  เนื้อหาโดยยอ  เปนตน



สารบญั 
แท็บสารบัญ  จะแสดงหัวขอของหลักสตูรอบรม  และแบบทดสอบทั้งหมด  เรียงตามลําดับ 

รวมถึงแสดงรายละเอียดโดยยอของเนื้อหาในแตละบท 

5.2 การลงทะเบียนอบรม 
หลังจาก Login เขาสูระบบแลว  ผูเขาอบรมสามารถเขาไปที่หนาลงทะเบียนอบรม  แลว 

ลงทะเบยีนตามข้ันตอน  ดังนี้ 
1. คลิกในวงกลม  หนาชวงวันที่เปดอบรม 
2. คลิกที่ปุมลงทะเบียนเขารวมอบรม 

เมื่อลงทะเบียนแลว ระบบจะสง e-Mail ยืนยนัการลงทะเบยีนมายังผูเรียน  และจะปรากฎ 
ชื่อหลักสูตรที่ลงทะเบียนไวแลว ในหนาสมุดรายงาน



5.3  การเขาอบรม 
ผูใชสามารถเขาอบรมไดตามกําหนด  จาก Link ในสมุดรายงาน  หรือจากเมนหูลักสูตร 

อบรมที่หนาจอหลัก  เมื่อเขาสูเนื้อหาหลักสูตรที่ตองการอบรมแลว  ดําเนินขัน้ตอนดังนี้ 
1. คลิกที่แท็บ  สารบัญ 
2. คลิกที่หัวขอที่ตองการ 
3. ถาตองการเขาเรียนในบทอ่ืน  กดปุม “ไปบทที”่ 

5.4  การทําแบบทดสอบ 
เว็บฝกอบรม  เรื่อง  การสรางหนังสืออิเล็กทรอนิกส  มีแบบทดสอบ  3  สวน  ไดแก 

1. แบบทดสอบกอนอบรม  จํานวน 20 ขอ  ทําไดครั้งเดียว  กําหนดเวลา 20 นาที 
2. แบบทดสอบทายบท  แตละบทสามารถทําได 2 ครั้ง  โดยนับคะแนนสูงสดุ 
3. แบบทดสอบหลังอบรม  จํานวน 20 ขอ  ทําไดครั้งเดียว  กําหนดเวลา 20 นาที 

เปนแบบทดสอบชนิดเลือกตอบ  4  ตัวเลือก  โดยสามารถทําแบบทดสอบภายในกําหนด 
เวลา  เมื่อหมดเวลา  ระบบจะตรวจแบบทดสอบทนัที  ทั้งนี้ผูเขาอบรมสามารถทราบผลไดทันที 
วิธีการเขาทําแบบทดสอบ  สามารถทําไดเชนเดียวกับการเขาอบรม



วิธีการทําแบบทดสอบ 
1. คลิกที่ชื่อของแบบทดสอบ ในหนาเนื้อหา 
2. เลือกคําตอบเพียงขอเดียว 
3. เมื่อทําขอสอบเสร็จแลว คลิกทีปุ่ม “ตรวจขอสอบ”



5.5  เคร่ืองมือสนับสนุนการอบรม 
หลังจากผูเรียนลงทะเบียนอบรมเนื้อหาบทใดบทหนึ่งแลว  แท็บของเนื้อหาบทนัน้จะ 

เปลี่ยนไป  คือ  จะมีแท็บของเครื่องมือสนับสนนุการอบรมเพิ่มขึ้นมา 
ในระหวางกําลังอบรม  ผูเขาอบรมสามารถใชเครื่องมือการอบรม  เชน  กระดานขาว  และ 

เพื่อนรวมหอง  มีวิธีการใชงานดงันี้ 

กระดานขาว 
กระดานขาวเปนเครื่องมือที่ชวยใหผูเขาอบรมสามารถฝากขอความ  เพื่อใหผูรวมอบรม 

สามารถเขามาอานขอความได  วิธีการใชกระดานขาว  มีขั้นตอนดังนี้ 
1. คลิกที่แท็บ กระดานขาว 
2. ใสหัวขอคําถาม 
3. เลือกรูปไอคอนขอความ 
4. กรอกขอความที่ตองการในชองรายละเอียด 
5. ถาตองการใสรูป  ใหเลือกรูปไดโดยการคลิกทีปุ่ม Browse 
6. คลิกทีปุ่ม  สงคําถาม



5.6  การเพกิถอนการอบรม 
ผูอบรมสามารถทําการเพกิถอนเนื้อหาหลกัสูตรตาง ๆ  ไดในระหวางอบรม  จากหนาตาง 

สมุดรายงาน  มีขั้นตอนดังนี้ 
1. คลิกที่ปุม Edit ทายบรรทดั ของเนื้อหาบททีต่องการเพกิถอน 
2. คลิกในชองสีเ่หลีย่ม ทําเครื่องหมายถกูทีช่องตองการพกัการอบรมหลักสูตร 
3. คลิกที่ปุม Submit



5.7  ใบประกาศนียบตัร 
เมื่อจบหลักสูตรการอบรม  วิทยากรจะทําการประเมินผูเขาอบรม  ถาผูเรียนผานเกณฑที่ 

กําหนด  จะปรากฎใหเหน็ในหนาสมุดรายงาน  ผูอบรมสามารถคลิกทีช่ื่อหลักสูตร  เพื่อเขาไปดู 
ใบประกาศนียบตัร  และสามารถพิมพใบประกาศนียบัตรออกมาทางเครื่องพิมพได



ประวัติผูวิจัย



ประวัติผูวิจัย 

ชื่อ–ชื่อสกุล  นางสาวกนกพร  ตฤปอัชฌา 
วัน เดือน ป เกิด  10  ตุลาคม  2525 
ท่ีอยูปจจุบัน  21/43  ถนนสนามบิน  อําเภอเมือง  จังหวัดพิษณุโลก  65000 
ท่ีทํางานปจจบุัน  คณะแพทยศาสตร  มหาวิทยาลัยนเรศวร  จังหวัดพิษณุโลก  65000 
ตําแหนงหนาท่ีปจจุบัน  เจาหนาที่บรหิารงานทั่วไป  หนวยประกันคณุภาพการศึกษา 
ประวัตกิารศกึษา 

พ.ศ. 2552  กศ.ม. (เทคโนโลยีและสื่อสารการศกึษา  แขนงคอมพวิเตอรศึกษา) 
มหาวิทยาลัยนเรศวร 

พ.ศ. 2547  นศ.บ. (การประชาสัมพนัธ) มหาวิทยาลัยนเรศวร



ประวัติผูวิจัย 

ชื่อ–ชื่อสกุล  นางสาวสิริญญา  นิ่มนวล 
วัน เดือน ป เกิด  18  มีนาคม  2520 
ท่ีอยูปจจุบัน  421/1  ถนนมหาจักรพรรดิ์  อําเภอเมือง  จังหวัดพิษณโุลก  65000 
ท่ีทํางานปจจบุัน  โรงเรียนโรจนวิทยมาลาเบีย่ง  อําเภอเมือง  จังหวัดพิษณุโลก  65000 
ตําแหนงหนาท่ีปจจุบัน  ครู 
ประวัตกิารศกึษา 

พ.ศ. 2552  กศ.ม. (เทคโนโลยีและสื่อสารการศกึษา  แขนงคอมพวิเตอรศึกษา) 
มหาวิทยาลัยนเรศวร 

พ.ศ. 2545  ป.วค. (ประถมศึกษา) มหาวิทยาลัยสุโขทัยธรรมาธิราช 
พ.ศ. 2542  ศศ.บ. (อุตสาหกรรมทองเที่ยว) มหาวิทยาลัยราชภัฎพิบูลสงคราม



ประวัติผูวิจัย 

ชื่อ–ชื่อสกุล  นางสาวสุพรรษา  พลับจุย 
วัน เดือน ป เกิด  5  มิถุนายน  2524 
ท่ีอยูปจจุบัน  23/2  หมูที่  3  ตําบลทาบัว  อําเภอโพทะเล  จังหวัดพจิิตร  66130 
ท่ีทํางานปจจบุัน  วิทยาลัยชุมชนพิจติร  หนวยจัดการศกึษาทบัคลอ 

อําเภอทับคลอ  จังหวัดพิจิตร  66150 
ตําแหนงหนาท่ีปจจุบัน  อาจารยพิเศษ 
ประวัตกิารศกึษา 

พ.ศ. 2552  กศ.ม. (เทคโนโลยีและสื่อสารการศกึษา  แขนงคอมพวิเตอรศึกษา) 
มหาวิทยาลัยนเรศวร 

พ.ศ. 2547  บธ.บ. (คอมพิวเตอรธุรกิจ) มหาวิทยาลัยราชภัฎสวนสนุันทา


